
Chapter 1

Introduction to 
AutoCAD Map 3D 2018

Learning Objectives
After completing this chapter, you will be able to:
• Understand various terms associated with Map 3D 
• Start AutoCAD Map 3D 2018
• Use workspaces
• Work with various components of AutoCAD Map 3D
• Use AutoCAD Map 3D Help
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INTRODUCTION 
AutoCAD Map 3D is a Geographic Information System (GIS) application developed by Autodesk. 
This application along with the standard AutoCAD drafting tools is equipped with tools for 
capturing, editing, updating, and analyzing geospatial data. Moreover, the interoperability feature 
of this application enables it to read, write, and convert data from one spatial data format to 
another. AutoCAD Map 3D supports various raster and vector data formats such as .tiff, .dem, 
.jpeg, .dwg, .shp, .dgn, and .tab. It also supports survey data in file formats such as .xyz, .gps, 
and .csv. The features in AutoCAD Map 3D enable you to connect to the spatial data using the 
relational database management system (RDBMS), thereby enhancing the productivity and 
helping in managing and analyzing a large spatial dataset efficiently. 

The tools and options available in AutoCAD Map 3D help you to perform complex geospatial 
data analysis and obtain accurate results, thus making it ideal for infrastructure planning, 
management, and decision making.

In this chapter, you will be introduced to the concept of geospatial analysis. Next, you will learn 
about the user interface of AutoCAD Map 3D and some of the data types that are used in the 
field of Geographical Information System. 
 

GEOSPATIAL ANALYSIS
Application of statistical analysis and other analytical techniques (such as network analysis, buffer 
analysis, and overlay analysis) to interpret the data related to a geographical area is known as 
geospatial analysis. Geospatial analysis includes various methods of data interpretation such as 
analyzing, interpreting, and presenting the GIS dataset using GIS software. This type of data 
analysis is widely used in urban planning, landscape designing, geographical mapping, utility 
management, navigation, and disaster management. 

Various types of GIS data such as vector data, raster data, survey data, and point data are used in 
geospatial analysis. Different types of data are suitable for different types of geospatial analysis. 
As a result, the selection of the spatial data type depends on the scope and requirement of 
the project. In case the spatial data is not available in the required data type, the process of 
conversion of data from one data type into another is usually practiced. Some of the commonly 
used GIS data are discussed next.

Vector Data
Vector data is a GIS data structure that represents geographical features in point, line, and 
polygon geometry. It can also store the non-spatial information of the geographic feature in 
a data table. The vector data format is used to create, edit, analyze, and store large amount of 
spatial data. Vector data stores geographic features using three basic geometry types, namely 
point, line, and polygon. These feature data types are discussed next. 

Point Feature
A point feature represents a spatial point for a specific object. A post box, street lamp, fire 
hydrant, and tree are some of the geographical objects that are represented as point objects. 
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Line or Polyline Feature
A line or polyline feature is used to represent a linear feature or a streamlined feature data such 
as roads, transmission lines, streams, rivers, pipe networks, and boundaries.

Polygon Feature 
A polygon feature (parcel) is a closed polyline object with the attribute or property data attached 
to it. The polygon feature is used to represent an area feature such as council boundary, plots, 
farms, zones, wards, and water bodies such as lakes and ponds.

Raster Data
Raster data consists of a matrix of cells, also known as pixels, organized into rows and columns. 
Each cell in a raster contains a value that represents information, such as elevation and 
temperature. You can graphically display the data in the raster by using various rendering 
techniques. These techniques help you to render data in various color schemes. 

You can insert a raster file into a drawing and then use it to collect information. In AutoCAD Map 3D, 
you can also import point files (elevation data) and LiDAR data into the workspace and then 
generate 3D raster surfaces. You can also analyze and display the raster data using various tools.

Drawing Object and Object Data
In GIS, there are three primary types of geometries: point, line, and polygon. These geometries  
are used to represent different geographic features in the drawing; for example, a road feature 
represented using a line segment. These geometries in the drawing are known as the drawing 
object. The drawing object may also have data associated with it. For example, a road feature 
may have data such as speed limit, name, and length associated with it. The associated data is 
known as object data. 

Some of the terms used in this book, related to drawing objects, are explained next.

Property
The property of a drawing object refers to the display parameters such as color, thickness, and 
pattern of drawing object.

Attribute 
Attribute refers to the non spatial data that is attached to a drawing object and does not provide 
any information about the display parameters of the drawing object it is attached to. For example, 
the area and population of a state attached to a closed polyline object (polygon), records of births 
and deaths pertaining to a geographical place attached to a point object, number of accidents 
attached to a line or polyline object (roads, streets, highways, or motor ways). 

Data Table
Data table is a way of presenting property and attribute values in the form of a table. It is attached 
to an object, a layer, or a feature in a Workspace. Figure 1-1 shows various parts of a data table.
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Figure 1-1  Various parts of a data table

Data Field
In a data table, the data field displays a group of attribute values related to a specific data 
object. A data field is also referred to as an attribute or a property.

Attribute Value
Attribute value of a drawing object is the value corresponding to the drawing object in various 
data fields. For example: attribute value of the Line object02 drawing object in the No. of 
vehicles/hr data field is 157, refer to Figure 1-1. 

Survey Data
Survey data is the point, line, or polygon data obtained by locating specific survey on the earth 
surface. Instead of storing survey data in isolated, individual files: GIS allows you to store all 
survey data in one database. It basically stores 3D data of a particular geographic location. The 
survey data can be obtained by using survey instruments such as total station, GPS, and so on. 

Industry Model Data
Industry Model Data is a new name given to the topobase database. Topobase is the database 
that includes features, parcels, and attribute data of a geographical location. Industry model 
data includes project settings, privileges, attribute data, and coordinate and projection systems 
related to a project. The projects such as infrastructure project management, utility designing, 
and facility management extensively use the industry model data for project management. 

Note
To create an industry model, you need to have the Autodesk Infrastructure Administrator 
application installed on your system. To install this application, select the check box corresponding 
to Autodesk Infrastructure Administrator 2018 while installing the AutoCAD Map 3D 
2018 software.

LAYERS 
Layers are the overlays containing specific geometry, property, and attributes of a particular 
feature. You can transform data from one layer to another based on the file formats of data. In 
AutoCAD Map 3D, you can use layers in the form of the AutoCAD drawing layer (.dwg) and the 
vector or the feature layer (.shp/.sdf). These two layer types are discussed next.

AutoCAD Layer
AutoCAD layer is a drawing layer that contains drawing objects (text, point, line, and polygon) 
and their properties. You can create and modify a layer within a drawing file. To use AutoCAD 
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layer in any other software, you will need to export or save the AutoCAD drawing layer in the 
file format that is recognized by the other software. 

Vector or Feature Layer
Vector or feature layer is an independent layer that contains information about all feature data 
spatially related to a geographical location. This layer can be in the SHP or SDF file format. It 
is easy to transfer feature data from one software to another using these types of layers. 

STARTING AutoCAD Map 3D 2018
From the Start Menu, choose All Programs >

Figure 1-2  Starting AutoCAD Map 3D 
2018

 
Autodesk > AutoCAD Map 3D 2018 (Windows 10), 
as shown in Figure 1-2; the AutoCAD Map 3D 2018 
application will start. Alternatively, double click on the 
shortcut icon of AutoCAD Map 3D 2018 on the 
desktop.

WORKSPACE 		
Workspace is a combination of menus, toolbars, 
Ribbon, palettes, and control panels. It is used to 
represent a customized drawing environment based on 
user requirements. You can also customize a workspace 
to suit the working environment of a task. 

When you start AutoCAD Map 3D 2018 for the first 
time, the AutoCAD Map 3D - Select Your Default 
Workspace window will be displayed, as shown in 
Figure 1-3. In this window, you can read information 
about the three predefined workspaces that are 
available in AutoCAD Map 3D. These workspaces are 
Planning and Analysis Workspace, Maintenance 
Workspace, and 2D Drafting Workspace. 

Tip
You can choose a different workspace at any time after starting AutoCAD Map 3D application. 
To do so, select the required workspace option from the Workspace drop-down list in the Quick 
Access Toolbar.
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Figure 1-3  The AutoCAD Map 3D - Select Your Default Workspace window

To choose a workspace, select the radio button corresponding to that workspace and then 
choose the Select button in the AutoCAD Map 3D - Select Your Default Workspace window; 
the window will be closed and the AutoCAD Map 3D 2018 screen will be displayed with the 
selected workspace. The predefined workspaces in AutoCAD Map 3D are discussed next. 

Planning and Analysis Workspace
By default, the Planning and Analysis Workspace radio button is selected in the AutoCAD Map 
3D - Select Your Default Workspace window. As a result, when you choose the Select button in 
the window, AutoCAD Map 3D interface opens in the Planning and Analysis Workspace. In this 
workspace, the tools are grouped in different categories based on their uses in layout planning and 
GIS analysis. Figure 1-4 shows the Ribbon displayed in the Planning and Analysis Workspace. 

Figure 1-4  Partial view of the Ribbon in the Planning and Analysis Workspace

Note
The theory and tutorial sections of all the chapters in this textbook are discussed based on the 
Planning and Analysis Workspace Ribbon interface. Hence, it is recommended to retain default 
settings unless instructed otherwise. 
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Maintenance Workspace
The Maintenance Workspace is a Ribbon interface in which tools are grouped in different 
panels based on their usage in an industry model or project. The tools in this interface are 
very useful when you are working with an industry model data, an infrastructural project, or a 
utility project. Also, it helps to administer an entire project by specifying the required privileges 
to each member of the team. To invoke this workspace, select the Maintenance Workspace 
radio button in the AutoCAD Map 3D - Select Your Default Workspace window and then 
choose the Select button; the Maintenance Workspace will be displayed in the AutoCAD 
Map 3D interface. Figure 1-5 shows the Ribbon in the Maintenance Workspace. You can use 
various tools in this workspace to maintain an industry model data. 

Figure 1-5  Partial view of the Ribbon in the Maintenance Workspace

2D Drafting Workspace
The 2D Drafting Workspace is a customized interface for drafters and designers. This workspace 
is very helpful for those who are familiar with AutoCAD Ribbon and mostly work with the drawing 
data. In this workspace, the panels are customized based on the use of each tool in drafting. 
To invoke this workspace, select the 2D Drafting Workspace radio button in the AutoCAD 
Map 3D - Select Your Default Workspace window and then choose the Select button; the 
2D Drafting Workspace will be displayed in the AutoCAD Map 3D 2018 interface. You can use 
various tools in this workspace to maintain an industry model data.

SWITCHING WORKSPACES 
After starting the AutoCAD Map 3D application, you can switch from one workspace to another 
workspace. To switch from one workspace to another, select the corresponding option from the 
Workspace drop-down list located in the Quick Access Toolbar, refer to Figure 1-6; the current 
workspace will be replaced by the selected workspace. 

Figure 1-6  Choosing the Maintenance Workspace option from the Workspace drop-down list 

Note
The procedure of accessing tools and dialog boxes in the Map Classic Workspace are different 
from the procedure used in the other workspaces as mentioned previously in this chapter.
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AutoCAD Map 3D 2018 INTERFACE				  
AutoCAD Map 3D 2018 interface consists of drawing area, Ribbon, command line, Quick 
Access Toolbar, TASK PANE, model and layout tabs, and status bar, refer to Figure 1-7. 
The header section of the application interface displays the name of the current drawing 
file. The different components of the AutoCAD Map 3D 2018 interface are discussed next.

 

Figure 1-7  AutoCAD Map3D 2018 interface

Application Menu
The Application button is located at the top-left of the AutoCAD Map 3D 2018 screen. Choose  
the Application button; the Application Menu will be displayed, as shown in Figure 1-8. The 
menu contains some of the tools that are available in the Standard toolbar. Alternatively, press 
ALT+F to display the tools in the Application Menu. You can search a command using the 
search field on the top of the Application Menu. To search a command, enter the complete or 
partial name of the command in the search field; a list showing all possible commands will be 
displayed. You can click on the desired command from the list to activate it. 

By default, the Recent Documents button is chosen in the Application Menu. As a result, the 
recently opened drawings will be listed on the right in the Application Menu. Click on the required 
file name in the list to open the file. To open a file that is not listed in this menu, choose the 
Open button in the Application Menu; the Select File dialog box will be displayed. Browse to 
the location of the required file. Click on the file name and then choose the Open button; the 
selected file will be opened in the drawing area. In AutoCAD Map 3D 2018, you can specify the 
settings of the Display, User Preferences, Files, and Drafting parameters in the Options dialog 
box. To invoke this dialog box, choose the Options    button displayed at the bottom-right of the 
Application Menu. Next, use the options in this dialog box to specify the required parameters.

To exit AutoCAD Map 3D, choose the Exit AutoCAD Map 3D 2018 button from the Application 
Menu.
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Figure 1-8  The Application Menu

Ribbon
Ribbon interface in AutoCAD Map 3D contains tools organized into various tabs and panels 
based on their functionality, refer to Figure 1-7.

When you start the AutoCAD session for the first time, by default the Ribbon is displayed 
horizontally below the Quick Access Toolbar. The Ribbon consists of various tabs. These tabs 
have different panels which in turn have tools arranged in rows. Some of the tools have a small 
black down arrow. This arrow indicates that the tools having similar functions are grouped 
together. To choose a tool, click on the down arrow next to them; a drop-down will be displayed. 
Choose the required tool from the drop-down displayed. Note that if you choose a tool from 
the drop-down, the corresponding command will be invoked and the tool that you have chosen 
will be displayed in the panel. For example, to draw a circle using the 2-Point option, click on 
the down arrow next to the Center, Radius tool in the Draw panel of the Home tab; a drop-
down will be displayed. Choose the 2-Point tool from the drop-down and then draw the circle. 
You will notice that the 2-Point tool is displayed in place of the Center, Radius tool. In this 
textbook, the tool selection sequence will be written as choose 2-Point tool from Home > Draw 
> Circle drop-down.

The tools which are not displayed within the available area of the panel are placed in the 
expandable area of the panel. Panels with an expandable area have a down arrow displayed 
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to the right of its name. To view the tools in the expandable area of the panel, you can choose 
the down arrow. You can click on the push-pin in the expanded panel to keep it in the expanded 
state. Also, some of the panels have an inclined arrow at the lower-right corner. When you click 
on the inclined arrow, a dialog box is displayed. You can define the settings 
of the corresponding panel in this dialog box.

AutoCAD Map 3D allows you to change the default location of the Ribbon interface. To do so, 
right-click on the blank space in the Ribbon; a shortcut menu is displayed. Next, choose the 
Undock option from this menu; the Ribbon is undocked. After undocking the Ribbon, you can 
move, resize, anchor, and turn on the auto-hide option for the display of the Ribbon. To do so, 
right-click on the heading strip in the Ribbon; a shortcut menu will be displayed. Choose the 
required option from this menu. For example, to vertically anchor the floating Ribbon to the 
left of the drawing area, right-click on the heading strip of the floating Ribbon; a shortcut menu 
is displayed. Next, choose the Anchor Left < option from the shortcut menu; the Ribbon will 
be anchored to the left.

You can also customize the display of tabs and panels in the Ribbon. To do so, right-click on 
any of the tools in it; a shortcut menu will be displayed. On moving the cursor over one of the 
options, a flyout will be displayed with a tick mark before all the options. Also, the corresponding 
tab or panel will be displayed in the Ribbon. Select/clear the appropriate option to display/hide 
a particular tab or panel. You can also reorder the display of panels in the tab. To do so, press 
and hold the left mouse button on the panel to be moved. Next, drag it to the required position 
and release the mouse button; the panel will be moved. 

Drawing File Tabs
The Drawing File tabs displayed above the drawing area, refer to Figure 1-7, show the drawings 
that are currently opened. Using these tabs, you can quickly switch between drawings. The 
order in which these tabs are displayed is based on the sequence in which the files were opened. 

Drawing Area
The drawing area covers the major portion of the screen. In this area, you can draw objects by 
using various tools/commands. To draw an object, you need to define coordinate points. You can 
do so by using the pointing device. The cursor represents the position of the pointing device 
on the screen. There is a coordinate system icon at the lower-left corner of the drawing area. 

Drawing Status Bar							     
The Drawing Status Bar is displayed at the bottom of the drawing area and below the command 
window, refer to Figure 1-9. To customize the status bar options, choose the Customization 
button on the status bar; a flyout will be displayed. Choose options according to your needs.  The 
Drawing Status Bar displays the Coordinate System, Vertical Exaggeration, Isolate Object, and 
AutoCAD Map 3D Scale buttons. Various options in the Drawing Status Bar are discussed next.

Figure 1-9  The options in the Drawing Status Bar
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2D Mode Button
The 2D Mode button is used to make platform for 2D working environment. When 
you apply the map2d.dwt template settings to the current drawing, you will enter the 
2D drafting and designing environment and the 2D Mode button will be activated. 
The map2d.dwt is a template file that contains the settings of the 2D drawing 
environment.   

3D Mode Button
The 3D Mode button is used to switch from 2D to 3D working environment. When 
you apply the settings from the map3d.dwt template file, you will enter the 3D designing 
environment and the 3D Mode button will be activated.

Vertical Exaggeration
The Vertical Exaggeration is used to change the vertical scale of the drawing. It is used to raise 
or lower the vertical features which might appear too small or too big relative to the horizontal 
scale in the drawing. To specify the exaggeration factor for visual enhancement, click on the 
down-arrow next to the Vertical Exaggeration button in the Drawing Status Bar; a flyout will 
be displayed. In this flyout, choose the required option; the display of the raster image will 
be enhanced based on the factor selected. Figure 1-10 shows the view of a raster image at the 
default vertical exaggeration (1x). Figure 1-11 shows an enhanced view of the raster image at 
vertical exaggeration of 2x.

Figure 1-10  Model vertically exaggerated to 1x Figure 1-11  Model vertically exaggerated to 2x

You can also specify a custom value for vertical exaggeration. To do

Figure 1-12  Choosing 
the Custom option for 
vertical exaggeration

 
so, click on the down-arrow corresponding to the Vertical Exaggeration 
option; a flyout will be displayed. In this flyout, choose the Custom 
option, as shown in Figure 1-12; a window will be displayed. In this 
window, enter the desired value in the Enter Exaggeration Value edit 
box and then choose the OK button; the window will be closed and 
the raster image will be vertically exaggerated to the specified value. 

Warning Button
The Warning button is used to display the details of the errors 
that have occurred while performing an action. By default, this 

button is inactive. When an error occurs, this button becomes active 
(it will be highlighted in yellow color). To view the description of the 
error occurred, click on the Warning button; the AutoCAD Map 
Messages dialog box will be displayed. This dialog box has two areas: Messages and Message 
details. Next, select a message in the Messages area; the details pertaining to the selected 
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message will be displayed in the Message details area. You can use the Show Log File button 
to view additional information about the selected option. On choosing this button, the log file 
of the error will be displayed in a text editor such as Notepad. 

Click to link/unlink AutoCAD Map 3D stylization while zooming
After a style has been applied to a vector data, you can use this button to link or unlink 
the AutoCAD Map 3D stylization while zooming. If the lock in this button is closed, the 

style applied to the vector layer will be displayed at different zooming scales (stylization linked). 
If the lock in this button is open, the style applied to a vector layer will not be displayed (stylization 
is not linked). 

Annotation Scale
The Annotation Scale option has a drop-down list that displays all the annotation 
scales available for the current drawing. The annotation scale is used to control the 

size and display of the annotative objects in the model space.

Annotation Objects
If this option is selected, then the annotated objects in the drawing are scaled automatically 
based on the scale selected in the Annotation Scale drop-down list.

 
Drawing Coordinates
The information about the coordinates is displayed on the left side of the Status Bar. You can 
set the display of coordinates in the Status Bar to static or dynamic. To change the coordinate 
display settings in the Status Bar, enter COORDS in the command line; you will be prompted 
to specify a new value. Specify a new COORDS value in the command line. If the value is set to 
0, the coordinate display will be static, which means that the coordinate values displayed in the 
Status Bar will change only when a point is specified. Setting the value of the COORDS variable 
to 1, 2, or 3 will display the coordinate in dynamic mode. If the variable is set to 1, AutoCAD 
Map 3D constantly displays the absolute coordinates of the graphics cursor with respect to the 
UCS origin.

Note
When you assign a global coordinate system to a workspace, the coordinates of a spatial point with 
reference to the assigned coordinate system will be displayed in the Drawing Coordinates area.

Infer Constraints
You can choose the Infer Constraints button to automatically apply the geometric 
constraints while you create or edit a geometric object. 

Snap Mode
The Snap Mode button is chosen to activate the grid snap mode. If this mode is activated, 
the cursor will move in fixed increments using the current settings of the snap grid. The 

F9 key acts as a toggle key to turn the snap mode off or on. To change the snap spacing, right-click 
on the Snap Mode button; a shortcut menu will be displayed. Choose the Settings option from 
the menu; the Drafting Settings dialog box will be displayed with the Snap and Grid tab chosen 
by default. In the Snap spacing area of this tab, specify the required snap spacing along the X 
and Y axes in the corresponding edit boxes. Next, choose the OK button to apply the settings.
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Grid 
The grid lines are used as reference lines to draw objects in AutoCAD Map 3D. Choose 
the Grid button to toggle the display of the grid in the drawing area. Alternatively, you 

can use the F7 key to toggle the grid display. To change the spacing of the grid lines, right-click 
on the Snap Mode button; a shortcut menu will be displayed. Choose the Settings option from 
the menu; the Drafting Settings dialog box will be displayed with the Snap and Grid tab chosen. 
In the Grid spacing area of this tab, specify the required spacing along the X and Y axes in the 
corresponding edit boxes. Next, choose the OK button to apply the settings.

Ortho Mode
This button is used to activate or deactivate the ortho mode. When this mode is active, 
you can draw lines at right angles only. Alternatively, choose the F8 key to turn this mode 

on or off.

Polar Tracking
If you turn the polar tracking on, the movement of the cursor is restricted along a path 
determined by the angle set as the polar angle. Choose the Polar Tracking button to turn 

the polar tracking on or off. You can also use the F10 key to turn this option on or off. Note 
that turning the polar tracking on, automatically turns off the ortho mode. 

Object Snap
You can use the Object Snap button to turn the object snap mode on or off. Alternatively, 
you can use the F3 key to turn the object snap mode on or off. Note that the status of 
OSNAP (off or on) does not prevent you from using the immediate mode object snaps.

3D Object Snap
When this button is chosen, you can snap the key point on a solid or a surface. You can 
also use the F4 key to turn the 3D object snap on or off.

Object Snap Tracking
When you choose this button, the inferencing lines will be displayed. Inferencing lines are 
dashed lines that are displayed automatically when you select a sketching tool and track 

a particular key point on the screen. On choosing this button, the object snap tracking turns on 
or off.

Allow/Disallow Dynamic UCS
On choosing this button, you are allowed or disallowed the use of dynamic UCS. Allowing 
the dynamic UCS ensures that the XY plane of the UCS is dynamically aligned with the 

selected face of the model. You can also use the F6 key to turn the DUCS button on or off.

Dynamic Input
The Dynamic Input button is used to turn the Dynamic Input on or off. Turning it on 
facilitates the heads-up design approach because all the commands, prompts, and 

dimensional inputs will now be displayed in the drawing area and you do not need to look at 
the Command prompt all the time. This saves the design time and also increases the efficiency 
of the user. If the Dynamic Input mode is turned on, you will be allowed to enter the commands 
through the Pointer Input boxes and the numerical values through the Dimensional Input 
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boxes. You will also be allowed to select the command options through the Dynamic Prompt 
options in the graphics window. To turn the Dynamic Input on or off, use the CTRL+D keys. 

Show/Hide Lineweight
Choose this button to turn on or off the display of lineweights in the drawing. If this button 
is not chosen, the display of lineweight will be turned off.

Show/Hide Transparency
This button is used to turn on or off the transparency set for a drawing. You can set the 
transparency in the Properties panel or in the layer in which the sketch is drawn.

Quick Properties
If you select a sketched entity when this button is chosen in the Status Bar, the properties 
of the selected entity will be displayed in a panel.

Model or Paper source
The Model or Paper source button is used to switch between the model space and 
paper space while in the layout space environment. Switching to model space while 

in the layout environment will enable you to work on the drawing objects in the model. To switch 
to model space in the layout environment, choose the Model or Paper source button; the 
drawing objects in the model will become editable and the text on the button will change from 
PAPER to MODEL.  To switch back to paper space, choose the Model or Paper source button; 
the paper space will be invoked and now you can work with the map elements in the layout.

Note
You can invoke the Layout space environment or the Model space environment in the drawing 
window by choosing the Model or Layout tab displayed at the bottom left of the drawing window, 
refer to Figure 1-7.

Toolbar/Window Positions Unlocked
The Toolbar/Window Positions Unlocked button is used to lock and unlock the positions 
of the toolbars and the windows. When you choose this button, a shortcut menu is displayed. 

Choosing the Floating Toolbars/Panels option allows you to lock the current position of the 
floating toolbars. Also, a check mark is displayed against those toolbars in the shortcut menu 
that are currently locked. Choosing the Docked Toolbars/Panels option from the shortcut menu 
allows you to lock the current position of all the docked toolbars. Similarly, you can lock or 
unlock the position of floating and docked windows such as the Properties window or the 
Tool Palettes. If you move the cursor on the All option, a cascading menu is displayed that 
provides the option to lock and unlock all the toolbars and windows.

Selection Cycling
You can use this button to select an object from the group of two or more overlapping or 
closely placed entities. To select an object from the overlapping entities, choose the 

Selection Cycling button in the Status Bar; the selection cycling mode will be activated. Next, 
click at the required location to select an object; a list box will be displayed. This list box contains 
a list of objects at the selected location. Choose the required object from the list to proceed.
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Command Line
The Command Line is located at the bottom of the drawing area where you can enter commands 
to execute an action. It also displays the subsequent prompt sequences and messages. You can 
change the size of the Command Line. To do so, place the cursor on the top edge of the command 
line; the cursor will change into a double line bar known as the grab bar. Click and drag the 
command line to change the size. This way you can increase its size to see all the previously 
used commands. Alternatively, you can press CTRL+9 to show or hide the Command Line. 
You can also press the F2 key to display the AutoCAD Text window which displays the previous 
commands and messages, as shown in Figure 1-13.

                         Figure 1-13  The Command Line 

TASK PANE			 
The TASK PANE is displayed on the right in the AutoCAD Map 3D 2018 screen, as shown in 
Figure 1-14. To hide/show the TASK PANE in the interface, choose the Map Task Pane button 
in the Palettes panel of the View tab.

You will find alternative options to the Ribbon interface in the   

Figure 1-14  The TASK PANE

TASK PANE. In the TASK PANE, there are four tabs: Display 
Manager, Map Explorer, Map Book, and Survey. These tabs are 
explained next.

Display Manager Tab
The options in the Display Manager tab are used to connect and 
display feature layers and then perform various types of analysis 
on these feature layers.
  
Map Explorer Tab
The options in the Map Explorer tab are used to assign the rights 
of a drawing to a user, attach new drawings to the current drawing, 
define queries, and so on. 

Map Book Tab
The options in the Map Book tab are used to divide a large map 
into small tiles. You can then render each tile on a separate page. 
You can publish map book online or can have paper print. 

Survey Tab
The options in the Survey tab are used to import and export the 
survey data, and create a data store.
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Navigation Bar
In AutoCAD Map 3D 2018, the commonly used tools for navigation are grouped together in a 
toolbar known as the Navigation Bar. By default, this toolbar is placed on the top right corner 
in the drawing area. Figure 1-15 shows the Navigation Bar available in the AutoCAD Map 3D 
2018. The tools in the Navigation Bar are discussed next. Note that if the Navigation Bar is 
not visible then you can invoke it by using the NAVBAR command.

Figure 1-15  The tools in the Navigation Bar

ViewCube
The ViewCube tool is used to switch between the standard and isometric views or to roll the 
current view. 

Full Navigation Wheel
The Navigation Wheel has a set of navigation tools such as pan, zoom, and orbit. You can use 
any of these options to set the view of a drawing in the drawing window. 

Pan
This tool allows you to view the portion of the drawing that is outside the current display area. 
To view the outside portion, choose this tool, press and hold the left mouse button, and then 
drag the drawing area. Press ESC to exit this tool.

Zoom 
A list of various zoom tools is displayed in the Zoom drop-down. The options in the Zoom 
drop-down are used to enlarge or reduce a view in the drawing window without affecting the actual 
shape and size of the objects in this view and generally by default, zoom extents tab is chosen. 

Orbit
The tools in the Orbit drop-down are used to rotate a view in the drawing window in the 3D space.

ShowMotion
Choose this button to capture different views in a sequence and animate them when required.
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InfoCenter Bar
By default, the InfoCenter bar is located on the right side in the AutoCAD Map 3D application 
title bar. This bar contains various options for accessing the help and online resources for 
AutoCAD Map 3D. Figure 1-16 shows various tools and options in the InfoCenter bar. Some of 
the options in this bar are discussed next. 

Figure 1-16  The InfoCenter bar

Autodesk 360
Autodesk 360 is a cloud computing platform introduced by Autodesk. This platform provides a 
set of cloud services and products that can help you share, simulate, visualize and design your 
work. You can access the Autodesk 360 services by using your Autodesk ID. 

To login to your Autodesk 360 account, choose the Sign In button in the InfoCenter bar; a 
drop-down list will be displayed. Next, select the Sign In to Autodesk 360 option from this list; 
the Autodesk-Sign In dialog box will be displayed, as shown in Figure 1-17. Enter your credentials 
in this dialog box and choose the Sign In button; Autodesk will validate your credentials and 
will provide access to your account. 

Figure 1-17  The Autodesk - Sign In dialog box
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After you login to your account, you can use various Autodesk 360 services such as the Live maps, 
data sharing, and so on. The usage of these services is discussed in detail in further chapters.

Tip
You can sign up for a free Autodesk ID by choosing the Need an Autodesk ID? link in the 
Autodesk - Sign In dialog box.

 

Autodesk Exchange Apps
On choosing the Autodesk Exchange Apps button from the InfoCenter bar, the Autodesk 
Exchange Apps website will be opened. This website is an online resource from where you can 
browse and download e-books, models, training materials, and add-ons for your AutoCAD 
product. Some of the products available are free to download. 

Stay Connected 
The option in this drop-down list is used to view and manage your Autodesk profile. When you 
choose the Autodesk Account option from this drop-down list, the Autodesk-Sign In page will 
be displayed wherein you can manage your profile.

InfoCenter Text Box and Search Button
If you need to search the AutoCAD Map 3D help based on a keyword, you can enter the required 
keyword in the text box of the InfoCenter bar and then choose the Search button. The application 
will search for the available topics related to the keyword entered, and will display the results in 
the Autodesk AutoCAD Map 3D Help window.  

Note
You can also invoke the Autodesk AutoCAD Map 3D Help window by pressing the F1 key.

Help
This drop-down list contains the options that provide links to various useful resources such 
as download offline help and language pack for Map 3D. Figure 1-18 shows various options 
available in the Help drop-down list. 

 Figure 1-18  The options in the Help drop-down list

You can also invoke the Autodesk AutoCAD Map 3D 2018 - Help window by selecting the Help 
option from this drop-down list. Figure 1-19 shows the default view of the Autodesk AutoCAD 
Map 3D Help window.

The default view of the Autodesk AutoCAD Map 3D 2018 - Help window provides you with 
the links to various Autodesk resources. These resources are organized into two basic categories: 
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Learn and Resources. You can explore the required resource by following the link displayed 
below the resource name. 

Figure 1-19  Partial View of the Autodesk AutoCAD Map 3D 2018 - Help window

You can also use the options in the various tabs displayed in the left pane of the Autodesk 
AutoCAD Map 3D 2018 - Help window to search and view the help topics in AutoCAD Map 
3D. You can choose the Contents tab to browse through the help topics that are arranged in a 
hierarchical order. You can also search the available help for a topic of your interest. To do so, 
specify the required keyword in the search text box of the Search tab and then press ENTER; the 
topics related to the specified keyword will be listed along with a short description in the left pane. 
Next, choose the required topic from this list; the content will be displayed in the right pane.

More Help
In AutoCAD Map 3D, you can access help using various methods as per your requirement. Some 
of these methods are listed on the below:

1.	 Access help from the command bar: While specifying a command through the command 
line, AutoCAD Map 3D displays a list of matching commands. This list also displays the 
Search in Help and Search on Internet buttons for the option highlighted in the list. You 
can choose the Search in Help button to search for relevant information about the selected 
option in the AutoCAD Map 3D help. Alternatively, you can choose the Search on Internet 
button to search for information online. Figure 1-20 shows the Search on Internet button 
being chosen from the displayed list.

Figure 1-20  Choosing the Search on Internet button
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2.	 Displaying the Tooltip: You can display help regarding various tools and buttons in form of 
tool tips. To do so, hover the pointer over a tool or button; a short description related to the 
chosen button or tool will be displayed in a tooltip. To activate or deactivate a tooltip, invoke 
the Options dialog box by entering the OP command in the command line. Next, choose the 
Display tab in the Options dialog box. In the Window Elements area of the Display tab, select 
or clear the Show ToolTips check box to activate or deactivate the tooltip, refer to Figure 1-21.

Figure 1-21  Selecting the Show ToolTips check box in the Options dialog box

3.	 Almost all dialog boxes in AutoCAD Map 3D have a Help button. You can access help on 
various topics by choosing this button. In case, the Help button is not displayed in a dialog 
box, press the F1 key on the keyboard; the help window for the dialog box will be displayed.

AutoCAD Map 3D DIALOG BOXES
There are certain commands which when invoked display a dialog box. A dialog box is a secondary 
window that allows the users to specify attributes and parameters to perform different tasks. It 
is also used to provide the users with information or progress feedback. A typical dialog box 
has a name assigned to it. It also contains controls such as the radio buttons, text or edit boxes, 
check boxes, slider bars, image boxes, and command buttons. Figure 1-22 shows some of the 
components in a dialog box.

The Title Bar displays the name of a dialog box. Tabs contain various sections with a group of 
related options under them. The check boxes are toggle options for making the corresponding 
option available or unavailable. The drop-down list displays a list of items to choose from. The 
text box is an area where you can enter any text such as file name. It is also called an edit box 
because you can make changes to the text entered in it. In some dialog boxes, there is the [...] 
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button which when chosen displays another related dialog box. There are certain command 
buttons (OK, Cancel, and Help) at the bottom of the dialog box. 

The names of these buttons imply their functions. The button with a dark border is the default 
selected button. A dialog box may also have a Help button which when clicked will show related 
help on various features of the dialog box.

   Figure 1-22  Components of a dialog box

COMMONLY USED ABBREVIATIONS IN GIS 
Some of the commonly used file formats and abbreviations in the field of GIS are listed in the 
table below.

Abbreviation  Description

 GIS  Geographical Information System

 DWG  Drawing file (AutoCAD file format)

 DWT  Drawing template file (AutoCAD file format)

 DWF  Design Web Format (AutoCAD file format)

 SHP  Shape file (ESRI file format)

 SDF  Spatial Data File (Autodesk file format)

 CSV  Comma Separated Values (MS Excel file format)

 TXT  Text file

 JPEG  Joint Photographic Experts Group (Image file) 
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 TiFF  Tagged Image File Format (Image file)

 ISD  Index file generated for point cloud data

 LAS and
 LSD

 LiDAR data file format

 GPS  Global Positioning System

 CAD   Computer Aided Design 

 TIN  Triangular Irregular Networks

 DBMS  Database Management System

 AM/FM  Automated Mapping/Facilities Management

 PRJ  Projection

 UTM  Universal Transverse Mercator

 WGS  World Geodetic System

 IDW  Inverse Distance Weighted

 RMSE  Root Mean Square Error

 GCP  Ground Control Points

 COGO  Coordinate Geometry

 NAD  North American Datum

 DEM  Digital Elevation Model

 DIME  Dual Independent Map Encoding

 DPI  Dots Per Inch

 CRS  Coordinate Reference System

Self-Evaluation Test
Answer the following questions:
 
1.	 The __________ Workspace is used for layout planning and GIS analysis. 
	 		
2.	 You can specify the settings of the Display, User Preferences, Files, and Drafting parameters 

in the  __________  dialog box.			 
	
3.	 The __________ button helps to snap the key point on a solid or a surface.

4.	 The COORDS command is used to change the coordinate display settings in the Status 
Bar. (T/F) 

5.	 The options in the Survey tab are used to divide a large map into small tiles. (T/F)

Answers to Self-Evaluation Test
1. Planning and Analysis, 2. Options, 3. 3D Object Snap, 4. T, 5. F


